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No part of this document may be copied, reproduced, extracted or transmitted in any form or by any 
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PIXELHUE). 

Trademarks 

 is a trademark of Pixelhue Technology Ltd. 
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Statement 

Thank you for choosing PIXELHUE products. This document is intended to help you understand and use 
the products. PIXELHUE may make improvements and/or changes to this document at any time and 
without notice. If you experience any problems in use or have any suggestions, please contact us via 
the contact information given in this document. We will do our best to solve any issues, as well as 
evaluate and implement any suggestions. 

This document could contain technical inaccuracies or typographical errors. Changes are periodically 
made to the information in this document; these changes are incorporated in new editions of this 
document. 

The latest edition of user manuals can be downloaded from the official website of PIXELHUE.  
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1.1 About This Manual  

This user manual guides you how to use our product. This manual is designed to be a 
reference for your daily use of our product. 

 Note  

Always check for the latest version of all documents at www.pixelhue.com.  

1.2 Version History  

Version Date Description 

V1.2.0 2023-03-15  Updated some hardware descriptions. 

 Updated some software pictures and descriptions. 

V1.1.0 2022-11-9  Updated the device rear panel picture. 

 Updated the 4K input card and 2K output card pictures 
and descriptions. 

 Updated the descriptions and user interface pictures 
of the built-in software Pilot MS3. 

V1.0.0 2022-5-30 First release 

1.3 Symbols and Pictures  

Symbol Overview 

  Danger Indicates a hazard with a high level of risk, which if not 
avoided, will result in death or serious injury. 

  Warning Indicates a hazard with a medium or low level of risk, which if 
not avoided, could result in minor or moderate injury. 

  Caution Indicates a potentially hazardous situation, which if not 
avoided, could result in equipment damage, data loss, 
performance degradation, or unexpected results. 

  
Note Provides additional information to emphasize or supplement 

important points of the main text. 

Picture Overview 

Images and pictures given in this manual are used for illustration purposes only. The 
actual product may vary due to product enhancement. The content of the images can 
be slightly different from reality, such as device types, installed modules, form and 
position of software windows on the screen. 

http://www.pixelhue.com/
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2 Safety 

Overview 

 General Considerations 

 Device Carrying 

 Device Mounting 

 Cable Requirements 

 Electrical Safety 

 Unpacking and Inspection 

 Device Labels 

 Notes and Cautions 
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2.1 General Considerations 

To ensure that you can use this product correctly and safely, please be sure to 
observe the following precautions: 

 Before performing any operation, make sure that you have read all the operating 
instructions provided by the device, especially the instructions that may endanger 
the personal safety and device safety, such as dangers, warnings and cautions, to 
minimize the probability of accidents. 

 All the operations must conform to local safety codes. When the safety and 
precautionary measures described in this manual conflict with local safety codes, 
please follow the local codes. 

 The personnel responsible for installing and maintaining the device must be 
professionals who have been trained and have mastered the correct operation 
methods and all safety precautions. Only trained and qualified personnel can 
perform device installation and maintenance. 

 This device must be used in an environment that meets the design specifications; 
otherwise, it may cause device failure. The resulting device function abnormalities 
or component damage, personal safety accidents, property losses and other 
situations are not included within the scope of the device warranty. 

2.1.1 General Safety 

 When operating the device, you must strictly abide by the local laws and 
regulations. The safety precautions described in this manual are only a 
supplement to the local safety laws and regulations. 

 The "Danger", "Warning" and "Caution" items described in this manual are only 
supplementary instructions for all safety precautions. 

 To ensure personal and device safety, please strictly follow all the safety 
precautions on the device labels and described in this manual when installing the 
device. 

2.1.2 Environmental Requirements 

 Ensure adequate air flow in the equipment room. 

 Take necessary measures to prevent dust, water and static electricity. 

 Avoid long-term direct sunlight. 

 Keep the device away from heat and ignition sources. 

 Do not place the device in an explosive atmosphere. 

 Do not place the device in a corrosive environment. 

 Do not place the device in a strong electromagnetic environment. 
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The following table outlines the physical environment where the device can be safely 
stored and operated. 

Environmental 
Requirements 

Operating Environment Storage Environment 

Temperature 0°C to 45°C –20°C to +70°C 

Humidity 0% RH to 80% RH,  

non-condensing 

0% RH to 95% RH,  

non-condensing 

Air Cleanliness ISO 14644-1 ISO 9  N/A 

2.1.3 Device Safety 

 Before operating, fix the device on the floor or other stable objects, such as a wall 
or mounting bracket. 

 During transportation and use of the device and its packaging, the device must be 
fixed stably to avoid falling. 

 Do not step on, hit and violently operate the device and its packaging to prevent 
damage to the device or packaging box. 

 Do not block the ventilation openings during operation.  

 Tighten the board or card screws with a tool. 

 After the installation, remove the empty packing materials from the device area. 

 Save the packing box and materials for possible storage and transportation in the 
future.  

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Avoid dropping any object into the chassis. 

 Keep the device away from conductors that are easy to induce lightning to avoid 
lightning strikes to the device. 

 Do not make the circuit faces of the boards or cards contact each other. 

 Do not touch the circuit, components, connectors or wiring slots of the boards or 
cards with bare hands. 

 Do not repair the device without authorization. Only trained professionals can 
maintain the device. You can contact Pixelhue at any time if needed. 

 Always use the spare parts recommended by Pixelhue. 

 Regularly clean the dust on the heat dissipation holes to prevent the dust from 
blocking the holes and thus affect the heat dissipation of the device. 

2.1.4 Personal Safety 

 Place the device in a stable location to prevent personal injury caused by falling. 

 Avoid bare wires and maintain or replace them in time when they are damaged. 

 Do not operate the device and connect cables outdoors under thunderstorms. 

 Do not wear watches, rings, or other metal jewelry when installing spare parts or 
maintaining the device. 
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2.2 Device Carrying 

 Do not relocate a powered device, and do not take any objects that may cause 
danger to the relocation. 

 Always pay attention to the wheels at the bottom of the flight case during 
transportation to avoid them being jammed by stones or deformed due to external 
forces. 

 Always hold the handles of the flight case firmly when pushing a flight case with 
wheels. Do not stack other devices on the flight case. 

 The relocated device should be repacked in the original factory packaging. 

 When handling or placing the boards or cards, bare board components or 
modules, always package them individually. 

 When carrying the device with your bare hands, always wear protective gloves to 
avoid injury. 

 When carrying the device, handle it gently and always hold the handles of the 
device or drag the bottom edge of the device. Do not hold the handles of a device 
component. 

 When the device weight exceeds the carrying limit of a single person, carry it with 
multiple people or use a carrying tool. 

 When using a forklift or handcart for transportation, place the device stably to 
ensure the device will not tip over. 

The following table lists the maximum weights that adults can carry at a time 
specified by some organizations for your reference. 

Organization Weight 

CEN (European Committee for Standardization) 25 kg/55.13 lb 

ISO (International Organization for Standardization) 25 kg/55.13 lb 

NIOSH (National Institute for Occupational Safety and Health) 23 kg/50.72 lb 

HSE (Health and Safety Executive) 25 kg/55.13 lb 

General Administration of Quality Supervision, Inspection and 
Quarantine of the People’s Republic of China  

Male: 15 kg/33.08 lb 

Female: 10 kg/22.05 lb 

2.3 Device Mounting 

When the device is installed on a desktop or into a rack, the desktop or rack must 
bear at least 4 times the device weight. 

2.3.1 Mounting on a Desktop 

 Ensure the stability and grounding of the desktop or working table. 

 Ensure that the device is placed horizontally and do not turn it over or hang it on 
the wall. 

 Do not place other objects on the device. 
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 Do not put water cups, beverages and other containers with liquid close to or on 
the device to avoid liquid leakage and thus cause safety hazards. 

 If any object or liquid accidentally enters the device, stop using the device and 
disconnect the power cord and all cables connected to the device immediately, 
and then contact the after-sales personnel. 

 When handling a flight case with wheels, please lock and fix the wheels to prevent 
the device from sliding. 

 When stacking, ensure all the devices are stacked stably to avoid device damage 
and personal injury caused by falling.  

2.3.2 Mounting into a Rack 

 The rack must be fixed properly to avoid tilting and falling, and thus cause 
personal injury and device damage. 

 When a device is mounted into a rack, all mounting holes must be fixed with 
screws. 

 Ensure the rack is well ventilated. It is recommended to reserve at least 1U space 
between the stacking devices, and the heat dissipation vents must not be 
obstructed and keep at least 10 cm distance from other objects. 

2.3.3 Grounding 

 Connect the grounding wire first when installing a device, and disconnect the 
grounding wire at last when removing the device. 

 The connecting surface of the grounding wire and the device must have good 
conductivity. Spray painting is strictly prohibited, and there must be sufficient 
fastening force between the connecting parts. 

 Do not operate the device when the grounding conductor is not installed. 

 There must be no joints in the middle of the grounding wire, and it is strictly 
prohibited to install a switch or fuse on the grounding wire. 

 For devices using a three-pin socket, ensure that the ground terminal in the three-
pin socket is well grounded. 

2.4 Cable Requirements 

2.4.1 Power Cords 

 Warning  

Do not install or remove the power cord when the device is powered on. When the 
power cord core contacts the conductor, an electric arc or spark will be generated 
which may result in fire or eye injury.  

 Protect the power cord properly to prevent it from being punctured to avoid 
personal injury or fire caused by a short circuit. 

 To ensure the safety of the device and personnel, be sure to use the matched 
power cord. 
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 User-supplied cables must comply with local cable regulations and device cable 
requirements. 

 Before installing or removing the power cord, turn off the device power first. 

 Check the electrical plug regularly and wipe off the dirt or dust accumulated on 
the plug. 

 Before connecting the power cord, read the labels or markings on the power cord 
to make sure it is a matched one. 

The device is intended to operate from an AC power source with a voltage range of 
AC 100–240V~, 50/60Hz. Various standard plugs are shown in the figure below. 

US NEMA5/15 Europe CEE 7 China GB 2099 UK BS 1363 

    

E Earth   N Neutral   L Live 

2.4.2 Signal Cables 

 Before using a DVI signal cable, check whether the pins on the cable connector 
are vertical and even. If not, please replace the cable. 

 Before connecting the signal cable to the device, check whether there is any 
object in the device connector. If yes, remove the object first. 

 If the signal cable has not been used for a long time, discharge static electricity 
before using it. 

 Under normal working conditions of the device, it is recommended that non-
technical professionals do not perform hot-swapping to avoid device damage. 

2.4.3 Miscellaneous 

 Signal cables must be bound separately from strong current cables or high 
voltage cables. 

 When the temperature is too low, severe shock and vibration may cause brittle 
cracking of the plastic sheath of the cable. All cables should be laid and installed 
when the temperature is above zero. 

 If the storage temperature of the cable is below zero, the cable must be moved to 
room temperature and stored for more than 24 hours before laying and 
installation. 

 When carrying cables, especially in a low-temperature environment, always handle 
the cable with care. Violent handling, such as pushing down the cables directly 
from a high place, is prohibited. 
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2.5 Electrical Safety 

2.5.1 Battery 

 There is a danger of explosion if a battery is incorrectly replaced. Replace only 
with the same or equivalent type recommended by the manufacturer. 

 Always follow the relevant instructions to dispose of batteries. 

 Do not throw lithium batteries into fire. 

2.5.2 Electromagnetic Interference 

 Keep the device away from transformers, high-voltage power lines and high-
current devices. 

 Keep the device away from high-power broadcast transmitters. 

 If there is a mobile communication transmitter around the device, its interference 
degree should meet the requirements of relevant standards. If needed, take 
necessary measures to prevent interference, such as shielding and isolation. 

 When using hand-held wireless communication devices, such as interphones, 
keep at least 30 cm away from the device. 

2.5.3 Anti-Static 

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Always hold the board by the edges to avoid touching the circuits or components, 
and do not touch the chip with your hands. 

 The disassembled board must be packaged with anti-static packaging material 
before storage or transportation. 

2.6 Unpacking and Inspection 

2.6.1 Unpacking 

 After receiving the device, check whether the packing box is damaged. If there is 
any damage, do not open the box and contact the carrier in time to confirm the 
damage to the device and matters related to compensation. 

 After unpacking, save the packing box and materials for possible storage and 
transportation in the future. 

2.6.2 Inspection 

 When the packing box is in perfect condition, unpack the box. Check the 
appearance of the device for damage. If there is damage, please contact the 
salesperson. 

 Check the box contents according to the packing list described in the certificate of 
approval. If any item is missing, please contact the salesperson in time. 
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2.7 Device Labels 

Labels Description 

 

Shock hazard 

  

Multiple power inputs 

The device is powered by multiple power supplies. 
Disconnect all power cords when the device is powered off. 

 

Warranty void if removed 

Do not open the chassis. If this label is damaged, the device 
will not be covered by the warranty. 

  

 

Grounding 

The two ends of the grounding wire are connected to the 
device and the grounding point respectively, which means 
that the device must be grounded through the grounding 
point to ensure the normal operation of the device and the 
personal safety of the operators. 

 

Sensitive electronic device 

Keep the device away from areas with strong 
electromagnetic radiation to avoid electromagnetic 
interference and thus affect the image output quality. 

 

Device carrying 

The device needs to be carried by multiple people. 

2.8 Notes and Cautions 

2.8.1 Notes for Battery 

 The battery is not intended to be replaced. 

 Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of 
a battery can result in an explosion. 

 Leaving a battery in an extremely high temperature surrounding environment can 
result in an explosion or the leakage of flammable liquid or gas. 

 A battery subjected to extremely low air pressure may result in an explosion or the 
leakage of flammable liquid or gas. 

2.8.2 Notes for Installation 

When the product needs to be installed on the rack, 8 screws at least M5*8 should be 
used to fix it. The rack for installation shall bear at least four times the total weight of 
the mounted equipment. 

a) Elevated Operating Ambient - If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may 
be greater than room ambient. Therefore, consideration should be given to 
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installing the equipment in an environment compatible with the maximum 
ambient temperature (Tma) specified by the manufacturer. 

b) Reduced Air Flow - Installation of the equipment in a rack should be such 
that the amount of air flow required for safe operation of the equipment is 
not compromised. 

c) Mechanical Loading - Mounting of the equipment in the rack should be such 
that a hazardous condition is not achieved due to uneven mechanical 
loading. 

d) Circuit Overloading - Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the 
circuits might have on overcurrent protection and supply wiring. Appropriate 
consideration of equipment nameplate ratings should be used when 
addressing this concern. 

e) Reliable Earthing - Reliable earthing of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other 
than direct connections to the branch circuit (e.g. use of power strips). 

2.8.3 FCC Caution 

Any changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.  

This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense. 

2.8.4 Others 

 This is Class A product. In a domestic environment, this product may cause radio 
interference in which case the user may be required to take adequate measures. 

 This product can only be placed horizontally. Do not mount vertically or upside-
down. 

 Please read the manual thoroughly and use the product in accordance with the 
requirements. If you have any questions about the specifications, please contact 
us immediately. If you use the product improperly, not following the requirements, 
or for illegal purposes, you shall be solely responsible for any consequences 
arising therefrom. 
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3 Hardware Overview 

About This Chapter 

This chapter is designed to describe the hardware appearance, features and 
specifications of the X400 media server. 

Overview 

 Introduction 

 Features 

 Appearance  
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3.1 Introduction 

The X400 is PIXELHUE's brand-new professional media server specifically designed 
for various large-scale multimedia applications. The X400 adopts a modular and 
plug-in design, allowing users to flexibly choose the desired input and output cards to 
meet various connections needs. The X400 is equipped with a new generation of Intel 
processor, high-performance server-class motherboard, server-class graphics card, 
high-speed SSD and other excellent hardware features to ensure a highly smooth and 
stable on-site operation. 

The X400 has a built-in professional multimedia playback software Pilot MS3, 
allowing for the display and control 8K images in pixel-to-pixel mode or multiple 4K 
images simultaneously, and enabling users to freely unleash their stunning and 
creative mosaic ideas. Pilot MS3 features with an intuitive, easy-to-use and fully-
visualized graphical UI and provides complete functionalities required for media 
editing and broadcasting in professional stage performances, thus becoming the 
unrivaled choice for a large number of high-end rental and other creative display 
applications, such as stage performances, large-scale conferences, exhibitions, 
presentations and more. 

3.2 Features 

Software 

 Playback and real-time editing of all categories of media, including videos, 
pictures, audio, web pages, acquisition devices and NDI inputs 

 Various playback modes, including single program, single media, media collection, 
cross-program media and jump playback 

 Unlimited layers and unlimited programs 

 Powerful slices for diversified visual applications 

 Visualized management of slices, programs, playback and input sources 

 Flexible mosaic realizes your creative ideas 

 Auto preview and preview editing of next program 

 Media optimization for better media performance 

 Media image quality adjustment 

 Media mirroring, stretching, cropping supported 

 Crossfade and cut effects on program switching 

 Decoding of various mainstream video formats 

 Output mapping and markings for clear screen and connector correspondence 

 Automatic software startup and program playback 

 Project file management and packaging 

Hardware 

 8K or multiple 4K hardware decoding and rendering for smooth playback and 
flawless output 

 Plug-in and modular design for higher system stability 
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 Frame sync technology for synchronized and smooth display 

 Seamless primary and backup device switching safeguards your on-site operation 

 Infinite device cascading, synchronized by Genlock 

 EDID lock, ensuring no jump of connector resolution and display sequence 

 Intelligent thermal solution 

 Running status indication and fault alarm on front panel display 

 High quality XLR audio inputs and outputs 

 Central control via TCP/UDP protocol 

 4U rack mountable chassis 

 Industrial ruggedized design 

Configuration 

 HDMI 1.4 monitoring connector dedicated for software UI 

 Dual SSD built-in with dual OS 

 Dual authorization: dongle + license 

Interactive UI 

 Fully-visualized and friendly graphical UI, what you see is what you get 

 Customizable graphical UI layout 

 UI lock for safer unattended operation 

Power Performance 

Capability 
 Smooth playback of 1x 8K4K@60fps video, 4x 4K2K@60fps /6x 

4K2K@30fps videos, or 15x 2K1K@30fps videos 

 Unlimited layers 

Outputs 
 8192×1080@60Hz/4096×2160@60Hz or 2048×1152@60Hz 

output card 

 6x 4K or 24x 2K outputs 

 4:4:4 10-bit color sampling 

 Genlock and frame sync card 

Inputs 
 1920×1200@60Hz or 4096×2160@30Hz input card 

 4x 2K or 4x 4K inputs 

 NDI, streaming media and web page inputs 

Audio 
 XLR audio: 1x AUDIO IN, 1x AUDIO OUT L, 1x AUDIO OUT R 

 1x 3.5 mm audio input, 1x 3.5 mm audio output 

 Formats: mp3, aac, flac, amr, ape, wav, wma, ogg 

Control 
 Built-in Pilot MS3 Professional Multimedia Playback Software 

 Central control via TCP/UDP protocol 

 1x HDMI 1.4 connector for software UI 

 2x USB on front panel, 4x USB on rear panel 
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3.3 Appearance 

3.3.1 Front Panel 

 

No. Name Function 

1 Power button Press the button to power on or power off the device. 

 Note 

DO NOT unplug the power cord to power off the device. 

2 Display screen Display the device working, input and output statuses. 

3 USB ports 2x USB 3.0 

 Connect to the mouse and keyboard. 

 Insert the USB drive to import media files. 

3.3.2 Rear Panel 

 

 Notes 

 All product pictures shown in this document are for illustration purposes only. 
Actual product may vary. 

 The sync connectors may not be present for different device configurations. 

 The input and output cards do not support the hot swappable function. 
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Area Connector Qty Description 

CONTROL USB 4 4x USB 3.0 

 Connect to the mouse and keyboard. 

 Insert the USB drive to import media files. 

Ethernet 
ports 

2 Connect to the network. 

 1x Gigabit Ethernet port 

 1x 10G Ethernet port (reserved) 

CONTROL 
UI 

HDMI 1 1x HDMI 1.3 

Connect a monitor to display the user interface 
of the Pilot MS3 multimedia playback software. 

AUDIO Audio 
connectors 

5  XLR audio connectors 

− 1x AUDIO IN: Mic audio input connector 

− 1x AUDIO OUT-L: Audio output connector 
(left channel) 

− 1x AUDIO OUT-R: Audio output connector 
(right channel) 

 3.5 mm audio connectors 

− 1x input 

− 1x output 

 Note 

The audio device connected to the XLR audio 
input connector must have an independent 
power supply. 

SYNC Sync 
connectors 

2 Synchronize the mosaic images on multiple 
displays. 

GENLOCK 2 Synchronize the connected device units. 

I/1~I/2 Input card 
slots 

2 Please refer to the table in 3.3.3  Cards to select 
the desired input cards. 

O/3~O/8 Output card 
slots 

6 Please refer to the table in 3.3.3  Cards to select 
the desired output cards. 

Hardware/Software Performance 

Power supply 750 W  

CPU 11th Generation Intel® Core™ Processor 

Memory 64 GB DDR4 

Motherboard High-performance ASUS Server Motherboard 

Storage  System disk: Samsung M.2 SSD 250GB  

 Storage disk: Samsung M.2 SSD 1TB 

Graphics card NVIDIA RTX A4000  
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Sync card Quadro Sync II 

OS Windows 10 IoT Enterprise LTSC 

3.3.3 Cards 

The X400 provides the following input and output cards for your applications.  

Input Card 

4K Input Card 

 

2x HDMI 1.4 

 Downwards compatible with HDMI 1.3 

 Max. resolution of single connector: 4096×2160@30Hz 

 2x 4096×2160@30Hz inputs simultaneously 

 HDCP 2.2 compliant 

2K Input Card 

 
 1x DVI 

− Max. resolution: 1920×1200@60Hz, min. resolution: 
800×600@60Hz 

− Interlaced signal inputs supported 

 1x 3G-SDI 

− Downwards compatible with HD-SDI and SD-SDI 

− ST-424 (3G), ST-292 (HD) and SMPTE 259 (SD) standard 
video inputs  

− Max. resolution: 1920×1080@60Hz 

− Interlaced signal inputs supported 

− DOES NOT support input resolution and bit depth settings. 

Output Card 

4K Output Card 

 
 1x HDMI 2.0 

 1x DP 1.2 

− HDMI 2.0 and DP 1.2 output the same content. 

− Max. output resolution: 
8192×1080@60Hz/4096×2160@60Hz 

− HDCP 2.2 compliant 

− Mosaic output of multiple same-type connectors 

2K Output Card 

 

4x HDMI1.3  
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 Max. output resolution of single connector: 2048×1152@60Hz  

 Max. width: 2560 pixels (2560×972@60Hz) 

 Max. height: 2560 pixels (884×2560@60Hz) 

 4x HDMI mosaic outputs (2x2) by default  
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4 Applications 

About This Chapter 

This chapter is designed to introduce you to the X400 application scenarios. 

Overview 

 Applications - Single Unit  

 Applications - Dual Redundant 
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4.1 Applications - Single Unit 
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4.2 Applications - Dual Redundant 

 

 Note 

If the dual redundant application is required, please select the device configuration 
with sync connectors.  
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5 X400 Settings 

About This Chapter 

This chapter instructs you how to configure the X400 media server.  

Overview 

 Set Main Display 

 Change Resolutions 

 EDID Management 

 Output Mosaic 
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5.1 Set Main Display 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 

 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at 
the bottom left corner on each display.  

 For the Multiple displays item, select Extend these displays. 
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 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Check the box next to Make this my main display. 

5.2 Change Resolutions 

5.2.1 Set Standard Resolutions 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 
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 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at 
the bottom left corner on each display.  

 For the Display resolution item, select the desired output resolution. 

 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Repeat Step 2 to Step 4 to complete the resolution settings for other displays. 
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5.2.2 Set Custom Resolutions 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Display > Change resolution. 

 Change resolutions 

 

 Select the desired display. 

 Click Customize to show the customize window. 
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 Custom resolution-1 

 

 Click Create Custom Resolution. 

 Read the disclaimer information carefully and click Accept to show the Create 
Custom Resolution window. 

 Select the desired display. 

 Custom resolution-2 

 

 Set the horizontal pixels, vertical lines, refresh rate and scan type. 
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 Click Test and then click Yes on the window that appears. 

 Confirmation 

 

 Custom resolution-3 

 

 Click OK to complete the custom resolution settings. 

After a custom resolution is created successfully, it will appear in the custom area as 
shown in the figure below. 

 Custom resolution-4 
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5.3 EDID Management 

After the display resolution settings, you need to manage the EDID for precise 
identification of display properties and to avoid the on-site screen display disorder. 

Load EDID  

The procedure of how to load the EDID is as follows. 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 NVIDIA control panel 

 

 Click EDID (Monitor) next to a desired output connector of the current graphics card 
to show the EDID management window. 
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 EDID (Monitor) 

 

 Manage EDID  

 

 Click Export EDID and then name the exported EDID file in the window that appears. 

 Select the Load tab to show the EDID loading window. 

 Click Browse and then select the EDID file exported in Step 4. 

 In the Select Connector to force EDID area, select the desired connector. 
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 Load EDID 

 

 Click Load EDID. 

 On the dialog box that appears, click OK to complete loading the EDID. 

 EDID loaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the 
original EDID (Monitor) changes to EDID (File), the EDID is loaded successfully.  

 EDID loaded successfully 
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Unload EDID  

The procedure of how to unload the EDID is as follows. 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 Click EDID (File) to show the EDID management window. 

 EDID (File) 

 

 Select the Unload tab and then select the desired connectors. 

 Unload EDID 

 

 Click Unload EDID. 

 After the EDID is unloaded successfully, click OK on the dialog box that appears. 
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 EDID unloaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the EDID 
(File) changes to EDID (Monitor), the EDID is unloaded successfully.  

5.4 Output Mosaic 

The graphics card supports connector mosaic output. The output connector mosaic 
must observe the following rules. 

 The graphics card does not support irregular mosaic layouts. The mosaic layout 
must be 1×2, 1×3, 1×4, 2×2, 2×1, 3×1 or 4×1. 

 The output resolutions of the graphics card connectors that are used for mosaic 
must be the same. 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Workstation > Set up Mosaic. 

 Set up mosaic 
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 Click Create new configuration to show the mosaic settings window. 

 Mosaic settings 

 

 Select the screen number from the drop-down list of Number of displays. 

 Select the screen mosaic layout from the drop-down list of Topology (rows x 
columns). 

 Select the screen orientation from the drop-down list of Orientation of displays. 

 Click Next to proceed. 

 Select displays 

 

 Select the connected displays and then select their refresh rate and resolution. 

 Click Next to proceed. 
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 Arrange displays 

 

 Arrange the displays according to the screen arrangement and structure by dragging 
the available displays to the corresponding topology areas. 

 Arrange displays 

 

 Click Apply and then click Yes on the confirmation window. 

 Click Next to proceed. 
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 Adjust overlap and bezel correction 

 

You can perform overlapping adjustment or bezel correction to the vertical or 
horizontal edges of the display as needed.  

 Select whether to use the same settings for all the vertical or horizontal edges of 
the display in the Select how overlap/bezel correction is applied area. 

 Select the desired edges and then enter the overlap or bezel correction values for 
the selected edges. Click Apply after the settings are done. 

 Click Finish to complete the mosaic settings. 

 Mosaic completed 
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6 Software Overview 

About This Chapter 

This chapter introduces you to the user interface of the built-in multimedia playback 
software Pilot MS3.  

Overview 

 Introduction 

 Change UI Layout 

 Load Layout 

 Lock User Interface 
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 Note  

The software pictures and descriptions in this manual may vary with the actual 
product in your hand. For the latest software operation instructions, please visit our 
official website or contact the technical support to obtain the latest software user 
manual.  

6.1 Introduction 

After the software is started successfully, the main user interface is shown in Figure 
6-1. The functions of each area are described in Table 6-1. 

 User interface 

 

Table 6-1 User interface descriptions 

Area Item Description 

Menu bar File Project file operations include: 

 New: Create a new project. 

 Open: Open a saved project. 

 Save: Save the current project. 

 Save As: Save the current project as a new 
project. 

 Package Project: Package the current project 
and the media files in it as an independent 
project file for easy use in future. 
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Area Item Description 

Resource Manage the media files and input sources. 

 Add Local Media: Add the local media files. 

 Add Input Source: Add the network media, NDI 
screens and websites as input sources. 

 Delete All Media: Delete all the imported media 
files. 

 Delete All Inputs: Delete all the added input 
sources. 

Output Configure and manage the linked devices, screens 
and slices. 

Window Show or hide the desired areas of the Pilot MS3 user 
interface.  

Link  Link Settings: Enter the link settings page and 
configure the backup device. 

 Update to Backup: Manually synchronize the 
data on the primary and backup devices. 

Settings Perform the system, authorization, hotkey and MIDI 
binding settings. 

Help  View the user manual. 

 View the product-related information. 

 Check for the software updates. 

Tools  Open the Transcoding Assistant tool and 
perform the needed transcoding actions. 

语言
/Language 

Switch the UI language. 

Preview area  Output: View the content of the current output program. 

 Preview: Preview the content of the next program. 

− Cut: Send the currently previewed program to the screen 
without transition effect. 

− Take: Send the currently previewed program to the screen 
with the fade transition effect. 

− If Keep is selected and the program is sent to the screen 
via Take or Cut, the program will be played from the 
current playback progress in the preview area. 

− If Keep is not selected and the program is sent to the 
screen via Take or Cut, the program will be played from 
the beginning. 
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Area Item Description 

Editing area  Use layers to configure the output according to the on-site 
screen pattern. 

 Preview the output image. 

 : Adjust the output image brightness. The value ranges 
from –50 to + 50 and defaults to 0. 

 : Adjust the output volume. The value ranges from 0 to 100 

and defaults to 50. Click  to turn off the output audio. 

 : After selecting a layer or slice in the editing area, click this 
icon to capture the current frame of the selected layer or slice 
and add the captured image to the media library. 

 : Make the selected layer fill the screen area loaded by the 
output connectors where the layer is located and crosses. 

 : When the output image is moved out of the visible area, 
click this icon to restore the screen to the origin. 

 : Zoom in the editing area. 

 : Zoom out the editing area. 

Layer and 
program editing 
area 

 Add, control and mosaic the layers. 

 Edit, group and play the layers. 

Playback 
control area 

Control the playback of the programs or layers in the program. 

Media library 
and properties 
area 

Media 
Library 

Manage the media files. 

 Add the local media files. 

 Create folders to manage the media files 
efficiently. 

 Delete, replace or rename the media file. 

Input 
Sources 

Manage the input sources. 

 Add the network media, NDI screens and 
websites as input sources. 

 Delete the input sources. 

 Preview the input sources. 

 Enable or disable the preview of acquisition card 
sources. 

Properties Edit the layer or program properties. 

Others  Event 
Controller 

Enable or disable the event controller control. 

MIDI Open the MIDI Connection Settings window and 
connect the MIDI devices. 

 The output connection has been established. Click 
the button to disconnect the output. 
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Area Item Description 

 The output has been disconnected. Click the button 
to regain the connection. 

/   : Output normally. 

 : Fade to black. 

Click , the icon turns to  and the output 
fades to black. 

Click , the icon turns to  and the output 
displays image as usual. 

When the slider block is at the leftmost, the output is 
black; when the slider block is at the rightmost, the 
output is normal. 

The default FTB duration is 0.5s and the value ranges 
from 0 to 5s. 

 Note  

Pressing the Ctrl + ← / → key combination allows you to switch the display screen 
of the software main user interface.  

6.2 Change UI Layout 

Pilot MS3 allows you to adjust the user interface layout according to your using 
habits. You can save and load the adjusted layout. 

 Click  at the top right corner of the target area to unlock this area. 

The icon descriptions are as follows: 

  (highlighted): The area is locked and you cannot adjust its size and position.  

  (grayed out): The area is unlocked. Move the cursor to the edge of the area 
and then click and drag the edge to adjust its size.   

 Move the cursor to any edge of an area. When the cursor turns into a double-sided 
arrow, click and drag the mouse to change the area size. 

 Move the cursor to the title bar of an area, and click and drag the mouse to change 
the area position. 

 Click  at the top right of the user interface to save the adjusted layout. 
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 Save layout 

 

 Enter a layout name. 

The layout name is unique and it is recommended you set a name that is easy to 
recognize. 

 Click Save to save the layout. 

6.3 Load Layout 

When the interface layout has been adjusted by others, you can load your preferred 
layout simply by using this function, instead of adjusting it area by area. 

 Click  at the top right of the user interface to open the layout loading window. 

 Load layout 

 

 Select the desired layout from the list on the left. 

 Click Load to load the layout. 

You can also perform the following operations: 

 Delete: Delete the selected layout from the layout list. 

 Restore Default: Restore the current interface layout to the default style. 

 Cancel: Cancel the layout loading and exit the layout loading interface. 

6.4 Lock User Interface 

If you do not want others to operate the software when you are away, just simply use 
this function to lock the software interface. 
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 Click  at the top right of the user interface to open the UI locking window. 

 Lock user interface 

 

 Enter a password. 

 Set the opacity for the locking interface. 

100% is completely opaque. At this time, the editing interface is completely invisible 
and only the lock screen background can be seen. 

 [Optional] Click Change next to Background to select a picture to be displayed on the 
locking interface. 

 Click Lock to complete the locking settings and lock the interface. 

 Notes  

 The locking password and background are for one-time use only. When you want 
to lock the interface for a second time, please set the password and background 
again. 

 To unlock the user interface, just enter your password click  to show the Pilot 
MS3 interface. 
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7 Project Operations 

About This Chapter 

This chapter guides you on how to add media files, edit programs, set program 
playback sequence and media properties, save configuration data as an independent 
project file for future use and more.  

Overview 

 Create New Projects 

 Manage Media 

 Manage Layers 

 Build Application Environment 

 Produce Programs 

 Playback Control  

 Save Projects 
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7.1 Create New Projects 
There are three methods provided for you to create a new project. 

 After Pilot MS3 is started successfully, click New on the startup interface and 
select the save path for the new project, and finally click Save. The system will 
automatically create a project file. 

 Go to File > New, select the save path for the new project and click Save to create 
a new project. 

 Click  below the menu bar to create a new project. 

7.2 Manage Media 
Pilot MS3 supports pictures, videos, audio media files and website inputs. 

The supported media formats are as follows: 

 Video: avi, asf, wmv, flv, mkv, mov, 3gp, mp4, mpg, mpeg, ts, m4v, webm 

 Picture: jpg, bmp, gif, png, jpeg, ico 

 Audio: wav, mp3, wma, ape, aac, flac, ogg, dts, amr, alac 

 Office files: ppt, pptx 

 Notes 

Recommended video coding formats: 

 4K < resolutions ≤ 8K: H.265 (HEVC) or VP9 recommended 

 Resolutions ≤ 4K: H.264 (AVC) recommended 
 

For a better image quality experience, the following video bitrates are recommended. 

Recommended video bitrates for SDR uploads: 

Type Video Bitrate Standard Frame Rate 

(24 fps, 25 fps, 30 fps) 

Video Bitrate High Frame Rate  

(48 fps, 50 fps, 60 fps)  

4320 (8K) 75 to 90 Mbps 110 to 135 Mbps 

2160p (4K) 35 to 45 Mbps 53 to 68 Mbps 

1440p (2K) 16 Mbps 24 Mbps 

1080p 8 Mbps 12 Mbps 

7.2.1 Add Media 

Pilot MS3 supports both single media file importing and batch importing. 
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7.2.1.1 Import Files 

 Click the Media Library tab on the right pane of the user interface. 

 Right click the blank area in the Media Library area and select Add Local Media to 
open a local folder. 

 Select the target media files and click Open. Pilot MS3 will import the selected files 
to the media library automatically. 

 Importing a single file: Select the desired file and click Open to complete the 
importing. 

 Importing multiple files: Press the Shift/Ctrl key, select the desired files, and click 
Open to complete the importing. 

7.2.1.2 Import Folders 

There are three methods provided for you to import a folder. 

 Import folder 

 Right click the blank area in the Media Library area and select Add Local Folder to 
open a local folder. 

 Select the desired folder where the media files are stored, and click Open. 

The system will automatically import the media files in the target folder with their 
original names to the media library. 

 Replace folder 

 Right click the blank area in the Media Library area and select Add Folder. The 
system will automatically create a new folder. 

 Right click the folder and select Replace in the context menu. 

 Select the desired folder from the displayed dialog box. 

 Click Select Folder and the system will automatically import the media files in the 
target folder with their original names to the media library. 

7.2.2 Edit Media 

7.2.2.1 Media Optimization 

When the imported media or video resolutions are inconsistent, or the imported 
media resolution exceeds the processing capability of Pilot MS3, to facilitate future 
use, you can change the file resolution in advance by using this function. 

 Note  

Only the videos and .jpg pictures can be optimized to even resolutions only.  

 Select the picture or video that needs to be optimized from Media Library. 

 Right click the file and select Media Optimization in the context menu. 

 Set the desired parameters for the optimization. 
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 Media optimization 

 

If Lock Aspect Ratio is selected, you only need to set either width or height, and the 
other parameter value will be calculated automatically according to the current 
aspect ratio of the media. 

 Click Optimize and the system will automatically optimize the selected media file. 

7.2.2.2 Create Playback Collection 

The playback collection allows you to sort and combine multiple videos or pictures 
into a new collection source. All the videos and pictures in the collection will be 
played automatically according to the set mode. 

 Right click the blank area in the Media Library area and select Create Collection to 
open the Create Collection window. 

 Playback collection 

 

 Select the desired media files in the All Media area on the left side. 

 Click  at the top right in the All Media area to add the selected files to the 
Collection Media area on the right side. 

 Select the newly-added media in the Collection Media area. 
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 Change the media properties at the bottom. 

Table 7-1 Collection media properties 

Property Description 

Duration Set how long the selected media will be played. After the playback 
ends, the next media will be played automatically. 

If the duration is not set, the video file will be played according to its 
original playback duration, and the picture file will be played for 10 
minutes by default. 

Times Set how many times the selected media will be played. 

Playback Set the media playing order in the collection media. 

 Sequential: The media in the collection will be played in 
sequence. 

 Shuffle: The media in the collection will be played randomly. 

Switching Set the transition effect when the current media starts to play or 
stops the playing. Currently, only Cut and Fade effects are supported. 

Fade in Set the time length from when the current media starts to play to 
when the media is fully displayed. 

Fade out  Set the time length from when the current media starts to stop to 
when the media is stopped. 

 Repeat Step 2 to Step 5 to complete the settings of other media in the collection. 

 Click OK to complete the collection settings. 

 Double click the collection name, and the name becomes editable. Rename the 
collection and press Enter to confirm the change. 

 Note  

After a collection is created, the default name is Playback Collection. It is 
recommended you give it a new name that is easier for you to distinguish.  

7.2.2.3 Media File Group Management 

You can create folders to classify the added media files. 

 Right click the blank area in the Media Library area and select Add Folder. The 
system will automatically create a new folder. 

 (Optional) Double click the folder to rename it. 

 Select the desired media files and drag them to the new folder. 

 Notes  

 Hold down the Shift or Ctrl key, and select the target file or multiple files in Media 
Library. 

 After selecting a media file, right click it and select Insert Folder in the context 
menu to move the selected file to the newly-inserted folder. 
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7.2.2.4 Media File Context Menu 

Right click a media to show the media file context menu. 

 Media file context menu 

 

 Add Local Media: Add new media files into the media library. 

 Media Optimization: Change the coding, quality, code rate, frame rate, audio and 
resolution settings of the videos or pictures. 

Only the videos and .jpg pictures can be optimized to even resolutions only. 

 Create Collection: Create a collection media. 

 Change Playback Collection: Change the settings of the collection media. 

 Add Local Folder: Import a folder containing media files into the media library. 

 Insert Folder: Create a new folder and move the selected media files into the 
folder. 

 Rename: Rename the selected media or collection. 

 Replace Media: Replace the currently-selected media. When the media is replaced, 
the media in the program will also be replaced synchronously. 

 Access File Location: Open the storage location of the current media. 

 Delete: Delete the current media. 

 Properties: View the media properties, such as the name, size, format and more. 

7.2.3 Add Input Sources 

You can add the network media, website input sources, NDI input sources and input 
sources from acquisition devices. The system automatically identifies and adds the 
input sources from acquisition devices. You can also enable or disable the 
acquisition device. 

 Note  

When the acquisition card and its driver have been installed into the device 
successfully, Pilot MS3 will automatically identify and add the acquisition card input 
source.  
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7.2.3.1 Add Network Media 

Pilot MS3 supports adding the streaming media whose format is rtsp and rtmp as 
input sources. 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Network Media. The 
system will automatically open the network media adding window. 

 Add network media 

 

 Enter the media path in the URL text box. 

Make sure the media path begins with rtsp:// or rtmp://. 

 Click OK to complete the adding. 

7.2.3.2 Add Website Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Webpage. The website 
page will appear as shown below. 

 Add website input sources-1 

 

 Enter an URL in the address bar. 

 Press Enter to enter the website and select the content to be played. 

 Set the output resolution and mode of the webpage. 

Change the webpage output resolution form the first drop-down list next to Webpage 
Output at the top right. 
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Change the webpage output mode form the second drop-down list next to Webpage 
Output at the top right. The supported options include Default Mode and Screenshot 
Mode. 

 Default Mode: The default webpage output mode 

 Screenshot Mode: When the webpage displays the video monitoring images, this 
mode is recommended. 

 Click ×  at the top right to close the window and finish adding the website. 

 Note  

When multiple tabs are opened, the input source displays the tab you stay on before 
closing.  

 Add website input sources-2 

 

 1: Preview window where you can preview the input source image, input source 
name, type and resolution 

 2: List all the input sources with their names. 

− : The added network media 

− : The added NDI input source 

− : The input sources from the acquisition device 

− : The added webpage input source 

7.2.3.3 Add NDI Input Sources 

After Pilot MS3 is successfully installed, the NDI configuration tool NDI Sender that 
comes with Pilot MS3 will be installed. After NDI Sender is enabled, Pilot MS3 will 
automatically search for all the computers whose NDI sending functions have been 
enabled in the current network segment. 

Prerequisites 

 The computer running the NDI Sender and Pilot MS3 must be on the same 
network segment. 

 Make sure the computer running the NDI Sender and Pilot MS3 can communicate 
normally. 

NDI Settings 

 Double click the NDI Sender shortcut on the desktop to open the NDI Sender 
software. 
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 NDI Sender 

 

 Set the image position and size for NDI on the computer screen. 

There are two methods to set the NDI image position and size. 

 Click Select ROI and then click and drag the mouse to select the display area you 
want to send. 

 In the Sent ROI area, you can precisely set the position and size of the sent area. 

− x: The horizontal offset from the top left corner of the sent area to the screen's 
left edge 

− y: The horizontal offset from the top left corner of the sent area to the screen's 
top edge 

− w: The horizontal width of the sent area 

− h: The vertical height of the sent area 

After the settings, you can click Show ROI to see the image position and image size 
you have set. 

 Enter an NDI name. 

 Select the screen you want to send if there are multiple computer screens. 

 Enter the frame rate of the NDI image. The default value is 25. 

 Click Start to complete the NDI Sender settings. 

Add NDI Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add NDI Screen. The system 
will automatically search the current network segment for all the NDI-enabled devices 
and then show you the NDI list. 

 NDI list 
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 Select the NDI sources from the NDI list. 

 Select NDI sources 

 

 Enter an NDI name. 

After the name is changed here, the new name will be displayed under the Input 
Sources tab. 

 Click OK to complete adding an NDI source. 

Website Input Source Menu 

Right click an input source under the Input Sources tab to show the website input 
source menu. 

 Website input source menu 

 

 Add Input Source: Add the network media, NDI screen or webpage. 

 Rename: Change the input source name. 

 Set Loop Interval: Set how long the input source is previewed in the preview area. 

 Stop Loop Preview: Stop loop preview of the current input source in the preview 
area. 

 Restore Loop Preview: Perform loop preview of all the input sources in the preview 
area. 

 Delete: Delete the current input source. 

 Properties: View the relevant information of the input source, including the name, 
type, network address, resolution and frame rate. 

 Click  at the bottom right of the acquisition card to select whether to add the 
sources from the acquisition device.   
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7.3 Manage Layers 

7.3.1 Add Layers 

The layer is a container where you store the media file of a program. Before you edit 
the program, please add the layers and add the media files into the layers first. 

 Click + at the top left in the Plan area to add a layer. 

The new layer will be added to each program. 

 Change the layer position in the Editing Area to arrange the output slices and avoid 
overlapping perfectly. 

 Slice position 

 

 Select a layer and click the Properties tab on the right pane to show the layer 
properties. 

 Configure the layer-related properties by referring to Table 7-2. 

 Notes  

 When you click and drag the layer, the purple auxiliary lines appear to help you 
better align the layers. 

 When there are too many media items, you can search for the media item in the 
search box above. 

 

7.3.2 Layer Mosaic  

Applications 

When an image needs to be output by multiple connectors and pixel-to-pixel display 
is required, you can use this function to satisfy your needs. 
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 Layer mosaic effect 

 

Operating Procedure 

 Click  at the top left in the Plan area to open the layer mosaic window. 

 Layer mosaic-1 

 

 Select and drag the layers in the Layer Layout area to the Layer Mosaic Layout area. 
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 Layer mosaic-2 

 

 Arrange the layers in the way you prefer in the Layer Mosaic Layout area. 

 Layer mosaic layout 

 

 (Optional) Change the mosaic layer name in the Properties area on the right. 

 Click Save to complete the layer mosaic. 

After the mosaic is completed, a new mosaic layer will be displayed in the Plan area. 

7.3.3 Set Layer Properties 

Layer Menu 

Right click a layer in the Plan area to show the layer menu as shown below. 
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 Layer menu 

 

 Rename: Change the layer name. 

 Close Image: Do not display the image of the current layer in all the programs. 

 Close Audio: Do not play the audio of the current layer in all the programs. 

 Lock layer: Lock the current layer in all the programs. After the layer is locked, the 
layer property changes will not take effect. 

 Forward/Backward: Adjust the order of the layer. 

 Insert Above: Insert a layer above the current layer row. 

 Insert Below: Insert a layer below the current layer row. 

 Clear Media: Clear the media in the current layer. 

 Delete Layer: Delete the layer in all programs. 

Layer Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface. 
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 Layer properties 

 

Table 7-2 Function descriptions 

Function Description 

Name View and change the layer name. 

Control Close Image: Do not display the image of the current layer, and only 
the audio is played. 

Size Change the layer size. 

 W: Set the layer size in the horizontal direction. 

 H: Set the layer size in the vertical direction. 

Volume Adjust the output volume of the current layer. The default value is 
100%. 

 Click  to turn off the audio. 

 Click  to reset the volume to default. 

Output Bind Select the rendering graphics card for the layer image. 

Flip Set the flipping mode of the output image. If H and V are not selected, 
the output image is displayed normally, without any flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the whole layer. 

 Proportional: The image is scaled and displayed in the layer 
according to its original aspect ratio. 

Brightness Set the overall brightness of the layer image. The value range is 0%–
100%, and it defaults to 50%. 
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Contrast Set the overall contrast of the layer image. The value range is 0%–
100%, and it defaults to 50%. 

Opacity Adjust the transparency of the output image. The value range is 0% 
(totally transparent)–100% (opaque), and it defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The value range is 0%–
100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the output image is. The 
value range is 0%–100%, and it defaults to 50%. 

Insert Above Insert a layer below the current layer row. 

Insert Below Insert a layer below the current layer row. 

Delete Layer Clear the layer data and delete the layer. 

Clear Layer Clear the data in the current layer. 

7.4 Build Application Environment 

In Pilot MS3, you can use the screens and slices to build an application environment 
according to your actual on-site needs. 

 Screen: Configure the output image displayed on the screen. 

 Slice: Configure the image output by the corresponding output connector. 

Click Output in the menu bar to open the Output Management window where you can 
relate the screens with the output connectors and change the screen position and 
sequence. 

 Output management 

 

7.4.1 Add Screens 

Each output connector on the discrete graphics card of the computer or server where 
Pilot MS3 is installed corresponds to a screen.  
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To synchronize output images, please refer to 5 X400 Settings to complete relevant 
configurations. 

Add and Bind Screens Automatically 

Pilot MS3 will automatically detect the graphics card connectors and then complete 
the adding and binding of those detected connectors. All the connectors are 
displayed in the output list on the left. 

Add and Bind Screens Manually 

When you add the graphics card to the control PC or change the saved project file, 
you can add the screens manually. 

 Click Add Screen at the top left to add an output. 

 Set the screen position and size according to the screen layout in the Screen 
Properties area on the right. 

 Screen management 

 

Table 7-3 Screen properties 

Menu Description 

Resolution The resolution of the screen loaded by the connectors 

Name Change the screen name. 

Binding Set the relationship between the output connector and screen. 

HDR Set the output dynamic range. The options include SDR and HDR. 

 SDR: The output is in SDR format. 

 HDR: The output is in HDR10 format. 

Position  X: Set the horizontal distance between the top left corner of the 
screen and the top left corner of the screen editing area. 

 Y: Set the vertical distance between the top left corner of the 
screen and the top left corner of the screen editing area. 
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Size Set the screen size. 

 W: Set the screen size in the horizontal direction. 

 H: Set the screen size in the vertical direction. 

Layout When there are multiple screens, use this function to arrange the 
screens quickly. 

 : All the screens are arranged in a 1×4 pattern. 

 : The screens are arranged in a 2×2 pattern. 

 : All the screens are arranged in a 4×1 pattern. 

Enable Mark Display a sequence number on the output connector and screen, which 
helps you easily identify and adjust the output pattern. 

Disable Mark Do not display the sequence number. 

Disconnect Do not show the output image of the current screen. 

Connect Show the output image of the current screen. 

 Configure the necessary parameters in the above table to complete the screen 
configuration. 

7.4.2 Add Slices 

Pilot MS3 uses the slices to output the image to the LED screen. Select the desired 
image area of the layer using the slice, and then map the image to the output 
connector to complete the image construction. 

 Click Output in the menu bar to open the Output Management window. 

 Select the Slice tab. 

 Screen slice and area descriptions 

 

 Layer List: Add and delete the rectangle or polygon slices. 

 Output | Slice: Adjust the output slice positions on the screen to construct the 
desired output image. 
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 Input | Slice: Adjust the sizes and positions of the input slices, and flexibly crop the 
input image.  

 Properties: Set the properties of the output slices and input slices.  

 : Slice filling configurations 

− In the input slice area, click  to make the selected slice fill the layer. 

− In the output slice area, click  to make the selected slice fill the screen. 

 : Restore the canvas to the origin. 

 : Maximize the output slice or input slice area. 

Add Rectangle Slices 

 In the Layer List area, select the desired layer to add the slices. 

 Click + next to the layer name, and then select Rectangle Slice to add a rectangle 
slice. 

 In the output slice area, change the position and size of the output slice, as well as 
view the output image. 

 In the input slice area, change the position and size of the input slice to crop the 
input image. 

Add Polygon Slices 

 In the Layer List area, select the desired layer to add the slices. 

 Click + next to the layer name, and then select Polygon Slice to add a polygon slice. 

To add a polygon slice, you need to draw the polygon manually. During the drawing, 
please note that the sides of the polygon cannot intersect.  

 Move the cursor to the input slice area, and the cursor turns to a pen head. Click the 
polygon vertices in sequence according to the polygon style you want to draw to 
complete the polygon drawing. 

 Add polygon slices 
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 Configure the properties of the polygon slice as required. 

1. Select the polygon slice. 

2. In the Advanced area on the right pane, enable the anchor editing function. 

3. Click the desired anchor and edit the anchor in the following two ways. 

− Click and drag the anchor to change the anchor position. 

− Click the anchor, and then press the arrow keys of the keyboard to change the 
anchor position. The moving stepping can be adjusted by setting the Stepping 
value in the Advanced area. 

Application Example 

If you want to output only the panda in Layer 3, do the followings. 

 Slice application example 

 

 Under the Slice tab, select Rectangle Slice 3-1 on the left side. 

 In the input slice area, move the input slice to cover the panda and adjust the slice 
size as needed. 

 In the output slice area, adjust the output slice size as needed and move the slice to 
the desired screen. 

7.4.3 Set Slice Properties 

Output Slice 

The output slices are used for the construction of the output image. The output slice 
outputs the image of the corresponding input slice, and then scales the input slice 
image according to the output slice size you set. Select the desired output slice in the 
output slice area, and then set the slice properties on the right. 
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 Output slice properties 

 

Table 7-4 Function descriptions 

Area Parameter Description 

Basic properties Name Display or change the name of the output slice. 

Position View or set the output slice position in the Output 
| Slice area. The origin of the Output | Slice area is 
the adjustment reference point and the 
adjustment unit is the pixel. 

 X: View or set the horizontal coordinate of the 
top left corner of the output slice in the Output 
| Slice area.  

 Y: View or set the vertical coordinate of the top 
left corner of the output slice in the Output | 
Slice area. 

Size View or set the output slice size. 

 W: View or set the output slice size in the 
horizontal direction. 

 H: View or set the output slice size in the 
vertical direction. 

 Click  between W and H to lock the slice 
aspect ratio. 

Ratio Set the aspect ratio of the output slice. 



X400 Professional Media Server User Manual 7 Project Operations 

 

www.pixelhue.com 65 
 

Area Parameter Description 

Rotation Rotate the output image clockwise based on the 
center of the output slice. 

Flip Set the flipping mode of the output image. 

 Horizontal: Flip the output image in the 
horizontal direction.  

 Vertical: Flip the output image in the vertical 
direction. 

Priority View or set the displaying priority of the output 
slice. 

 Display: Indicate the priority of the output slice 
by a number. The larger the number, the 
higher the priority, i.e., the more front the 
output slice is displayed. 

 Adjustment: Select the desired output slice, 

and then click , ,  or  to 
adjust its priority. 

Color properties Opacity Adjust the transparent degree of the output slice. 
The value ranges from 0% (totally transparent) to 
100% (nontransparent). 

R/G/B Adjust the RGB values of the output slice. 

Advanced Anchor Enable or disable the anchor editing function. 

Lines After the editing function is enabled, set the color 
of the anchor lines. 

Stepping After the editing function is enabled and you use 
the keyboard arrow keys to move the anchor, this 
parameter is used to set the anchor moving 
distance each time you press the arrow key. 

Position After the editing function is enabled, enter the 
specific values of X and Y to precisely position the 
anchor. 

Layers 

Select the desired layer in the input slice area, and then set the layer properties on the 
right. 

 Layer properties 

 

 Name: Display or change the name of the layer. 
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 Position: View or set the layer position in the input slice area. The origin of the 
input slice area is the adjustment reference point and the adjustment unit is the 
pixel. 

− X: View or set the horizontal coordinate of the top left corner of the layer in the 
input slice area. 

− Y: View or set the vertical coordinate of the top left corner of the layer in the 
input slice area. 

 Size: View or set the layer size. 

− W: View or set the layer size in the horizontal direction. 

− H: View or set the layer size in the vertical direction. 

− Click  between W and H to lock the slice aspect ratio. If one of the two 
values is changed, the other value will change automatically according to the 
aspect ratio. 

Input Slices 

Select the desired input slice (highlighted when selected) in the input slice area, and 
then set the input slice properties on the right.  

The input slice is used to select a specific image area of the input source image. 

 Input slice properties 

 

Table 7-5 Function descriptions 

Parameter Description 

Basic properties 

Name Display or change the name of the input slice. 

Position View or set the input slice position upon the layer. The top left corner of 
the layer is the adjustment reference point and the adjustment unit is the 
pixel. 

 X: View or set the horizontal coordinate of the top left corner of the 
layer slice upon the layer.  

 Y: View or set the vertical coordinate of the top left corner of the layer 
slice upon the layer. 
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Parameter Description 

Size View or set the input slice size. 

 W: View or set the input slice size in the horizontal direction. 

 H: View or set the input slice size in the vertical direction. 

Ratio Set the aspect ratio of the input slice. 

Rotation Set the rotate degree of the input slice. The reference point is the center of 
the output slice. 

Advanced properties 

Anchor  Enable or disable the anchor editing function when the input slice is a 
polygon slice. 

Lines  After the editing function is enabled, set the color of the anchor lines. 

Stepping  After the editing function is enabled and you use the keyboard arrow keys 
to move the anchor, this parameter is used to set the anchor moving 
distance each time you press the arrow key. 

Position  After the editing function is enabled, enter the specific values of X and Y 
to precisely position the anchor. 

 Note  

The rectangle slices in the input slice area do not support advanced property settings  

7.4.4 Configure Link Backup 

Pilot MS3 supports the device backup to set the backup relationship between two 
devices. You can set one of the devices as the primary device or the backup device. 
When the primary device has got a problem or the primary device's cable fails, the 
backup device will take over the responsibilities of the primary device seamlessly, 
and continue to work well to ensure the LED screen will not go black. 
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 Application 

 

Prerequisites 

 The primary and backup devices must be on the same network segment. 

 The primary and backup devices must be connected to the same downstream 
device, such as an F4 shown above. 

Operating Procedure 

 On the primary device, go to Link > Link Settings or click Output > Link. 
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 Link settings 

 

In the device list, the system will automatically search for all the online devices on the 
current network segment. 

Device status descriptions: 

 Name: 

− The media server name 

− : The device is online. 

− : The device is offline. 

 IP: 

− The device IP address 

− : The device is not used as a backup one. 

− : The device is used as a backup one. 

 In the device list, select the device used as a backup one. 

 Select the desired device and drag it to the target primary device to complete the 
backup settings. 
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 Backup settings 

 

Other Operations 

On the output management page, right click the backup device to show the context 
menu. 

 Context menu for backup device 

 

 Click Disconnect to disconnect the backup device from the primary device. Right 
click again and select Connect to reconnect them. 

 Click Remove to delete the backup device and remove the backup relation 
between the primary and backup devices. 

7.5 Produce Programs 

The playback unit of Pilot MS3 is the program.  
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After you have completed the construction of the outputs and added images to the 
layers, the system will output the image according to your construction (slices). 

7.5.1 Edit Programs 

The system provides 50 programs by default. Before the playback of a program, you 
must add the media files or input sources to the layers of the programs. 

Select the desired media file or input source in Media Library and drag it to the target 
program layer in the Plan area. 

 Edit programs 

 

The functions of the icons in the Plan area are described as follows. 

 : Return to the first program column. 

 : Locate the program that is being played or edited. 

 : Add a new program. 

 : Turn off the image display of the selected layer. 

 : Turn on the image display of the selected layer. 

 : Turn off the audio of the selected layer. 

 : Turn on the audio of the selected layer. 

7.5.2 Set Media Continuation 

When you want to play media content in the same layer of multiple continuous 
programs, you may need to add the same media file to each program. The added 
media will be played from the beginning when a new program starts, which may not 
be what you want to see. The cross-program media continuation function can 
perfectly solve this problem. After you have enabled this function for a specified 
media, the program will be played continuously but not played from the beginning 
when a new program is started. 

 Right click the desired media in the Plan area and select Cross-P Media Continuation 
from the context menu. 
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 Set media continuation 

 

 Click and drag the media to the target program. 

 Note  

Right click the target program media after the cross-program continuation, and then 
select Cancel Continuation to delete the continuation settings.  

7.5.3 Set Program Properties 

Program Menu 

Right click a program to show the context menu as shown in the following, and you 
can set the program properties as needed. 

 Set program properties 

 

 Play: Play the current program. 
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 Pause: Pause the program playback. The program will be played from where it is 
paused next time when it is played. 

 Stop: Stop the program playback. The program will be played from the beginning 
next time when it is played.  

 Map to Preview: Show the program content in the preview area. 

 Enable Keep: When the playback switches to the program, it starts to play from the 
last position.  

 Disable Keep: When the playback switches to the program, it starts to play from 
the beginning. 

 Rename: Change the program name. 

 Cut: Cut the current program. 

 Copy: Copy the current program and its properties. 

 Paste: Paste the copied program and its properties to the specified program. 

 Insert Before: Add a new program before the current program column.  

 Insert After: Add a new program after the current program column.  

 Delete Program: Clear all the layer data in the program and delete the program. 

Program Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface to show the program 
property settings. 

 Program properties 

 

 Name: View or change the program name. 

 Status: Display the playback status of the current program. 

 Keep: After this is enabled, when the playback switches to the program, it starts to 
play from the last position. After this is disabled, when the playback switches to 
the program, it starts to play from the beginning. 

 Switching: Set the transition effect for program switching. The options include 
Fade and Cut. 

 Fade In: When Fade is selected, set the duration for the current media to appear. 

 Fade Out: When Fade is selected, set the duration for the current media to 
disappear. 
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 Brightness: Set the brightness of the images in the program. 

 Contrast: Set the contrast of the images in the program. 

 Add Before: Add a new program before the current program. 

 Add After: Add a new program after the current program. 

 Delete Program: Clear all the layer data in the program and delete the program. 

Media Context Menu in Program 

Right click a media in a program in the Plan area to show the context menu. 

 Media context menu 

 

 Play: Play the current media. 

 Pause: Pause the media playback. The media will be played from where it is 
paused next time when it is played. 

 Stop: Stop the media playback. The media will be played from the beginning next 
time when it is played.   

 Cross-P Media Continuation: When you want to play a media in the same layer of 
multiple continuous programs, you may need to add the same media file to each 
program. The added media will be played from the beginning when a new program 
starts, which may not be what you want to see. The cross-program media 
continuation function can perfectly solve this problem. After you have enabled this 
function for a specified media, the program will be played continuously but not 
played from the beginning when a new program is started. 

 Cancel Continuation: After the cross-program media continuation function is 
enabled, this item is available and you can cancel the cross-program continuation 
settings. 

 Rename: Change the name of the media in the program. The media name in the 
media library is changed at the same time. 
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 Jump: Set the jump playback mode of the current media after the media playback 
ends. 

− Loop: Loop the playback of the selected media in the program, and then  
will be displayed at the top right of the layer in the Plan area. 

− EOF: The current media will stop the playing and display the last frame after 

being played once, and  will be displayed at the top right of the layer in the 
Plan area. 

− Stop: The playback will stop after being played once, and  will be displayed 
at the top right of the layer in the Plan area. 

− Next Program: Jump to the next program after the current media playback 
ends. 

− Jump to Specified Program: Specify the desired program and the specified 
program will be played automatically after the current program is completed. 

 Enable Keep: When the playback switches to the media, it starts to play from the 
last position.  

 Disable Keep: When the playback switches to the media, it starts to play from the 
beginning. 

 Enable/Disable Subtitle: Turn on or turn off the subtitle display for the selected 
media. 

 Cut: Cut the media in the layer of the current program. 

 Copy: Copy the media in the layer of the current program. 

 Paste: Paste the copied or cut media. 

 Copy Properties: Copy the properties of the selected media. 

 Paste Properties: Paste the copied media properties to another media. 

 Locate Media: Locate the current media file in the media library. 

 Delete Media: Delete the selected media. 

Program Media Properties 

 Select the desired media in a program. 

 Select the Properties tab on the right pane of the user interface to show the media 
property settings. 
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 Media properties 

 

Table 7-6 Media property descriptions 

Area Function Description 

Name View or change the media name. 

Time Duration View the length of the media playing time. 

Start Time 
Set the start time of the media playback. The start time 
value cannot be later than the media duration. 

End Time 
Set the end time of the media playback. The end time 
value is later than the start time, and cannot be later 
than the media duration. 

Delay Set the delay time of the media playback, that is, the 

duration the program is played before the media starts 
playing. 
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Play Play Set the playback mode of the current media during the 
playing time of the program. 

 Loop: Loop the playback of the selected media in 

the program, and then  will be displayed at the 
top right of the layer in the Plan area. 

 EOF: The current media will stop the playing and 
display the last frame after being played once, and 

 will be displayed at the top right of the layer in 
the Plan area. 

 Stop: The playback will stop after being played 

once, and  will be displayed at the top right of 
the layer in the Plan area. 

 Loop Times: Set the loop playback times of the 

current media, and  is displayed at the top right 
of the layer in the Plan area. ("N" stands for the 
number of loop times). 

Jump Set the jump playback mode of the current media after 
the media playback ends. 

 No Jump: No operation will be performed after the 
current media playback ends. 

 Next Program: Jump to the next program after the 

current media playback ends, and  will be 
displayed at the top right of the layer in the Plan 
area. 

 If you have enabled the program jump, the group 
name and program name of the next program are 

displayed and  will be displayed at the top right 
of the layer in the Plan area. 

Switching Set the transition effect for switching the current media 
in the program layer. The options include Fade and Cut. 

Fade In When Fade is selected, set the duration for the current 
media to appear. 

Fade Out When Fade is selected, set the duration for the current 
media to disappear. 

Keep After this is enabled, when the playback switches to the 
program, it starts to play from the last position. After 
this is disabled, when the playback switches to the 
program, it starts to paly from the beginning. 

Subtitle Turn on or turn off the subtitle display. 

Speed Set fast playback speed for the media. 

Volume Adjust the output volume of the media. 

Click  on the right of the volume to turn off the 
output volume of the layer. 
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Image Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the layer. 

 Proportional: The image is scaled and displayed in 
the layer according to its original aspect ratio. 

Flip Set the display mode of the output image. If H and V are 
not selected, the output image is displayed normally, 
without any flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Brightness Set the overall brightness of the layer image. The value 
range is 0%–100%, and it defaults to 50%. 

Contrast Set the overall contrast of the layer image. The value 
range is 0%–100%, and it defaults to 50%. 

Opacity Set the transparency of the output image. The value 
range is 0% (totally transparent)–100% (opaque), and it 
defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The value 
range is 0%–100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the output 
image is. The value range is 0%–100%, and it defaults 
to 50%. 

Y/C Stretch After enabled, the output image is brighter in the bright 
areas and darker in the dark areas.  

This function is disabled by default. 

Crop Crop  Cropping method: 

− Stretch: Stretch or shrink the output image. 

− Crop: Crop the output image. 

− Proportional: Scale down the output image. 

 Proportional: 

− Enabled: The unit for the cropping is the 
percentage. 

− Disabled: The unit for the cropping is the pixel. 

T: Set the size of the shrunk/cropped/scaled down 
area at the top part of the media. 

B: Set the size of the shrunk/cropped/scaled down 
area at the bottom part of the media. 

L: Set the size of the shrunk/cropped/scaled down 
area at the left part of the media. 

R: Set the size of the shrunk/cropped/scaled down 
area at the right part of the media. 
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Keying Remove a specific color from the selected media. 

Check the box next to Enable to enable the function. 

 Select the desired keying method to set the color 
to be keyed. 

Four keying methods are supported: 

− Click the eyedropper  and select the color 
to be removed on the screen. 

− Click the color block and select the color in 
the displayed Select Color window. 

− Next to #, enter the value of the color to be 
removed. 

− Double click the values next to RGB and enter 
their values, respectively, to precisely set the 
color. 

 Strength: The higher the value, the wider the 
keying color range and the stronger the color 
correction.  

When precise keying is required for a specific 
image, it is recommended to set the value smaller 
than 10%; for other cases, it is recommended to 
set it greater than 50%. 

 Shadow: The higher the value, the cleaner the noise 
area that contains shadows in the foreground. 

Borders Configure the size and color of the image borders. 

Check the box next to Borders to enable the 
function. 

 Set the border color. Four methods are available: 

− Click the eyedropper  and select the 
desired color on the screen. 

− Click the color block and select the color in 
the displayed Select Color page. 

− Next to #, enter the value of the desired color. 

− Double click the values next to RGB and enter 
their values, respectively, to precisely set the 
color. 

− Click the A value and enter a value to set the 
border opacity. The value range is 0% (totally 
transparent)–100% (opaque). 

 Set the border size. Two methods are available.  

− Percent: Set the percentage of the border size 
to the media. 

− Pixels: Set how many pixels the border 
occupies. 
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7.5.4 Set Program Jump 

After the program editing is completed, set the program jump to realize the automatic 
continuous playback of the programs. 

Before the program jump settings, you need to specify a media in each program as 
the timing base. After the playback of the selected media ends, the specified 
program will start to play. 

 Select the desired media in a program in the Plan area and right click the media to 
open the context menu. 

 Go to Jump > Jump to Specified Program and all the programs become selectable. 

 Program jump 

 

 Select the desired program to complete the jump settings. 

If you want to jump to a program in another group, click the name of the group where 
the program belongs, and then click the program name to complete the program 
jump between program groups. 

 Repeat Step 1 to Step 3 to complete the jump settings for more programs. 

After the program jump settings,  is displayed at the top right of the layer in the 
Plan area. 

 Note 

When two programs become jump partners for each other, they will be played 
circularly.  

7.5.5 Manage Program Groups 

When you need a large number of programs, you can create groups to manage those 
programs. Each group supports 20 programs by default. 

 Click + at the bottom left in the Plan area to add a program group. 
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 Add program groups 

 

 Right click the group name and select Rename to give the group a new name. 

 Rename groups 

 

 Click + at the top right to add new programs to the newly-added group. 

7.6 Playback Control 
After the program editing, you can play the programs. 

 Control the program playback. 

− Click  next to a program name in the Plan area to play the program. 

− Click  to pause the program playback. 

(The  icon turns to  during the program playback. The  icon 

turns to  after the program is paused.) 

− Click  to continue the program playback. 

 Switch the playback content. 

During the playback of a program, switch the playback content of a layer. For 
example, in the below figure, when Program 1 is being played, double click the 
media in Layer 2 of P 2 to switch the playback of the media.  
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 Playback control-1 

 

 Control the media playback. 

In the playback control area, control the playback of a single media or all the 
media. 

 Playback control-2 

 

− Click  or  on the left side to play or pause the playback of all media in a 

program; click  on the left side to stop the playback of all media in a 
program. 

− Click  or  next to a media name to play or pause the playback of the 
selected media. 

− Click  at the top right, and the program media adopts the count up timer. 

− Click  at the top right, and the program media adopts the countdown timer. 

− Click  at the top right, click the name of the program to be played 
synchronously and drag the media playback progress bar to play two media 
synchronously. 

− Click  at the top left to set the fast-forward and rewind speed. The 
options include 2s, 4s, 8s and 16s. (The number refers to the playback speed 
and the unit is second.) 

− Click  to set the fast-forward speed. 

− Click  to set the rewind speed. 

 Make sure you have deselected Move between slides in Settings > System 
Settings > Office, and the following playback actions can be taken. 

− After selecting a program, pressing the left and right keys allows for program 
switching. 

− After selecting a program, pressing the space bar enables play and pause 
functions for the selected program. 

 In the Preview area, click Cut or Take to send the preview program to the screen. 
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 Preview playback 

 

− Cut: Send the currently previewed program to the screen without transition 
effect. 

− Take: Send the currently previewed program to the screen with the fade 
transition effect. 

− If Keep is selected and the program is sent to the screen via Take or Cut, the 
program will be played from the current playback progress in the preview area. 
If Keep is not selected and the program is sent to the screen via Take or Cut, 
the program will be played from the beginning. 

 FTB: 

Click  at the upper left of the main interface and the output image will fade to 
black within the time you set. 

The time ranges from 0 to 5s and it defaults to 0.5s. 

7.7 Save Projects 

You can save the editing and settings as an independent project file for easy use in 
the future. 

 Go to File > Save or Save As to save the current project file (*.pms3) to your local 
storage. 

 Click  at the top left of the main interface to create a new project. 

 Click  at the top left of the main interface to save the current project. 

 Click  at the top left of the main interface to save the current project as a new 
project file. 

 Click  at the top left of the main interface to package the current project, such 
as all the used media or all the media files and project files, which is convenient 
for future use. 
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8 Software Settings 

About This Chapter 

This chapter introduces you to various settings of the software. 

Overview 

 System Settings 

 Authorization 

 Hotkey Binding 

 MIDI Binding 
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8.1 System Settings 

Set the startup-related settings. Go to Settings > System Settings to open the 
System Settings window. 

8.1.1 General 

 System settings 

 

Basic 

 Start software after power on 

− Selected: Automatically launch Pilot MS3 when the system is started. 

− Deselected: Do not automatically launch Pilot MS3 when the system is started. 

 Start software and open recent project after power on 

− Selected: Automatically open the last edited project when Pilot MS3 is 
launched. 

− Deselected: Display the default interface when Pilot MS3 is launched. 

 Play project after opened 

− Selected: When you open a project, the project will be played from where it 
stopped playing last time. 

− Deselected: When you open a project, no media will be played and the project 
interface will be displayed. 

 Auto save project 

Set an interval that the system will automatically save the project. The value 
ranges from 1 to 30 min and it defaults to 5 min. 

Canvas 

Set the background color of the editing area. 
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In the canvas settings area, change the background color of the editing area by 
selecting a preset color or customizing a color. 

After the basic and canvas settings are done, click OK to apply the settings. 

8.1.2 Display 

 Display settings 

 

Coding and Decoding 

 Main Program Window: Select the graphics card for the rendering of the program 
main user interface. After the configuration, you need to restart the software. 

 HDR: Enable the HDR rendering output. 

 SDR: Enable the SDR rending output. 

General 

 Fade In: Set the time length from when the current media starts to play to when 
the media is fully displayed. The value ranges from 0 to 10 s. When the value is set 
to 0 s, there is no transition effect. 

 Fade Out: Set the time length from when the current media starts to stop to when 
the media is stopped. The value ranges from 0 to 10 s. When the value is set to 0 
s, there is no transition effect. 

 Apply to All: Apply the duration of Fade In and Fade Out to all the programs. After 
the time length is set, if you do not click Apply to All, the transition will only be 
effective on the programs without the added media. 

 MFPS: Real-time frame rate 

− Selected: Display the real-time frame rate at the bottom right on the media 
preview window. 

− Deselected: Do not display the real-time frame rate on the media preview 
window. 

After the coding and decoding and general settings are done, click OK to apply the 
settings. 
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Synchronization 

Configure the synchronization mode for graphics cards. When multiple graphics 
cards are deployed in a mosaic setup, enabling the synchronization between the 
graphics cards is necessary to ensure the consistent display across the graphics 
card connectors. Check the Sync between graphic cards box to activate 
synchronization function. 

After completing the configuration, please restart the software for the system 
settings to take effect. 

8.1.3 Audio 

On the system settings window, click Audio to enter the audio settings tab page. 

 Audio settings 

 

Select an audio output channel from the drop-down list next to Channel. Click OK to 
complete the audio settings. 

8.1.4 Office 

Pilot MS3 supports playback of PowerPoint files. Before playback, configure the 
basic information of PowerPoint files. 

On the system settings window, Click Office to enter the office settings tab page. 
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 Office settings 

 

 Resolution: Set the resolution according to the resolution of the PowerPoint file. 

 Slide Transition: Set the transition of each slide of the PowerPoint document 
during playback. 

− Animation Mode: Show the animations of slides during playback. 

− Picture Mode: Do not show the animations of slides. 

 Use arrow keys to switch between slides 

− Selected: Allow arrow keys to be used to switch between slides. 

− Deselected: Arrow keys cannot be used to switch between slides. 

Click OK to complete the office settings. 

8.2 Authorization 

One authorization dongle corresponds to only one authorization file. When the dongle 
matches the authorization file, Pilot MS3 can be used normally. 

Pilot MS3 supports the centralized management of multiple authorization files. When 
an authorization dongle is inserted, the system can automatically identify the 
corresponding authorization file to ensure the normal operation of Pilot MS3. 

 Import the authorization file. 

 Go to Settings > Authorization to open the authorization settings window. 

 Click Import at the bottom to open the authorization file importing window. 

 Select the desired authorization file and click Open. The system will automatically 
import the file to Pilot MS3. 
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 Authorization file 

 

 Check the authorization. 

 Insert the authorization dongle into the system. 

 The system will automatically identify the authorization file according to inserted 
the authorization dongle, and then display In Use after successful identification. 

8.3 Hotkey Binding 

Pilot MS3 supports custom hotkeys, and users can use those keys to operate Pilot 
MS3 simply and conveniently. Go to Settings > Hotkey Binding to show the hotkey 
settings interface, and the areas where you can carry out the hotkey binding are 
highlighted. 

 Hotkey binding 

 

Click the target area, and then press the letter or number keys on the keyboard as 
needed to complete adding the hotkey. 
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After the settings, go to Settings > Complete Binding to make the hotkeys take effect 
and exit the hotkey binding interface. 

 Note  

The Ctrl+H key combination is a built-in global hotkey which can quickly locate the 
mouse to the center of the main interface. When you set the hotkeys, this 
combination cannot be used.  

For example: 

Set the hotkey for Program 1 to Q. 

a. On the hotkey settings interface, click Program 1. 

b. Press the letter Q on the keyboard, and then a letter Q will be displayed on 
Program 1. 

 

8.4 Hotkey Binding 

Pilot MS3 supports custom hotkeys, and users can use those keys to operate Pilot 
MS3 simply and conveniently. Go to Settings > Hotkey Binding to show the hotkey 
settings interface, and the areas where you can carry out the hotkey binding are 
highlighted. 

 Hotkey binding 

 

Click the target area, and then press the letter or number keys on the keyboard as 
needed to complete adding the hotkey. 

After the settings, go to Settings > Complete Binding to make the hotkeys take effect 
and exit the hotkey binding interface. 
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 Note  

The Ctrl+H key combination is a built-in global hotkey which can quickly locate the 
mouse to the center of the main interface. When you set the hotkeys, this 
combination cannot be used.  

For example: 

Set the hotkey for Program 1 to Q. 

c. On the hotkey settings interface, click Program 1. 

d. Press the letter Q on the keyboard, and then a letter Q will be displayed on 
Program 1. 
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9 Software Help Information 

About This Chapter 

This chapter introduces you the software-related and company-related information 
that may help you during the use. 

Overview 

 User Manual 

 About 

 Software Updates 
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9.1 User Manual 

Go to Help > User Manual on the menu bar to open and view the product user 
manual. 

9.2 Software Updates 

Check the current version of the software. When a new software version is detected, 
the system will download the latest version and then you can follow the instructions 
to complete the update. 

9.3 About 

View the software version, license agreement and other company-related 
information.
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10 Software Tools 

About This Chapter 

To better meet onsite playback requirements, Pilot MS3 has integrated some tools 
that can be used to edit video files. 

Overview 

 Transcoding Assistant
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10.1 Transcoding Assistant 

Pilot MS3 supports the conversion of the video coding format, code rate, resolution, 
and frame rate to satisfy the requirements of different playback scenarios. 

 Go to Tools > Media Transcoding to open the transcoding assistant window. 

 Transcoding assistant 

 

 Click Add at the bottom to open the local folder where you can select the desired file. 

You can also add multiple files by pressing the Ctrl key and selecting the files 
simultaneously. 

 Click Add to add them into the assistant. 

 Select the target video file. 

 On the right side, set the parameters of Coding, Quality, Code Rate, Frame Rate, 
Resolution and Audio. 

 Coding: Set the coding format of the transcoded video. The supported options 
include Adaptive, h264, h265, VP9 and hap. When Self-Adaptive is selected, the 
video will be transcoded according to the original video coding. 

 Quality: Set the quality of the transcoded video. The supported options include 
Low, Medium and High. 

− High: Keep the quality of the transcoded video the same as the original 
video quality. 

− Low: The quality of the transcoded video is relatively blurred compared to 
the original video quality. 

− Medium: The quality of the transcoded video is between the high and low 
qualities. 



X400 Professional Media Server User Manual 10 Software Tools 

 

www.pixelhue.com 96 
 

 Code Rate: Set the code rate of the transcoded video. The supported options 
include Self-Adaptive and Custom. 

− Adaptive: The code rates before and after the transcoding are the same. 

− Custom: Set the desired code rate and the video will be transcoded 
according to the set value. 

 Frame Rate: Set the frame rate of the transcoded video. The supported options 
include Self-Adaptive, 24, 30, 60 and Custom. 

− Adaptive: The frame rates before and after the transcoding are the same. 

− 24/30/60: The frame rate after the transcoding will be 24 Hz, 30 Hz, and 60 
Hz, respectively. 

− Custom: Set the desired frame rate and the video will be transcoded 
according to the set value. 

 Resolution: Set the resolution of the transcoded video. 

− W: Set the horizontal size of the transcoded video. The value defaults to 
1920 and can reach a maximum value of 16384. 

− H: Set the vertical size of the transcoded video. The value defaults to 1080 
and can reach a maximum value of 16384. 

 Audio: Set how to deal with the audio that comes with the video. The supported 
options include Keep and Remove.  

− Keep: The transcoded video retains the audio in the video before 
transcoding. 

− Remove: The transcoded video display pure images without any audio. 

 Click Transcode and the system will automatically start the transcoding process. 

When the progress reaches 100% in the Progress column, the transcoding 
completes. After the transcoding, the video will be saved in the path specified in Save 
Path. 

 Click Open to open the local folder where you can view the transcoded files. 

 Click Change to change the save path. 

 Click Delete at the bottom to delete the selected video files.
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11 External Control 

About This Chapter 

This chapter guides you how to control and use the X400 media server (Pilot MS3) on 
an event controller or other third-party devices. 

Overview 

 Control via Event Controller 

 Control via Stream Deck 
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11.1 Control via Event Controller 

If you are using the X400 media server (Pilot MS3) for your event, you can easily 
control it on the U3 and U5 series (U5 and U5 Pro) event controllers from PIXELHUE. 
This can be achieved through the joint control method and the KVM control method, 
providing convenient on-site device control. 

In the joint control scenario, the Pilot MS3 programs can be read and displayed on 
the event controller. You can then bind these programs to the event controller’s 
preset buttons, allowing you to effortlessly switch and play them. 

In the KVM control scenario, the Pilot MS3 user interface can be displayed on the 
event controller, enabling you to perform all Pilot MS3 operations using the event 
controller's mouse and keyboard, especially switching and playing programs. 

Furthermore, the above two control methods can be seamlessly combined, offering 
enhanced flexibility in managing the X400 media server for your event. 

11.1.1 Joint Control 

U3 Event Controller 

 Complete the physical connections. 

 Connect the U3 and X400 to the same local area network by either directly 
connecting them with an Ethernet cable or connecting them through a router. 

 Connect the X400’s CONTROL UI connector to a monitor using an HDMI cable. 

 Connect the X400’s Type-A ports to a keyboard and a mouse using USB cables. 

 Physical connections between the U3 and X400 
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 In Pilot MS3 on the monitor, click Event Controller in the upper right corner, as shown 
in Figure 11-2, to enable the X400 to be discovered by the U3 and displayed in the 
device list on the right side of the U3 primary screen, as shown in Figure 11-3. 

 Enabling the X400 to be discovered by the U3  

 

 Go to Settings > Peripheral on the event controller to enter the peripheral 
management page. 

 Peripheral management 

 

 From the device list of the U3 primary screen, select your online media server. 

 Green: The media server is online.  

 Gray: The media server is offline. 

Operations: 

 Refresh: All the peripheral devices are automatically identified and listed here. You 
can also tap Refresh to manually refresh the device list. 

 Delete: Select the target device and tap Delete. 

 On the U3 primary screen, select a program and drag it to the target preset button to 
bind the program to the desired preset button. 
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Binding rules are as follows: 

 One program can be bound to different buttons. 

 One button can be bound to only one program of a device. 

 One button can be bound to programs from different devices. 

Operations: 

 Sync: After a different device is selected or a program changes, the program list 
will be synchronized automatically to the event controller. You can also tap Sync 
to manually synchronize the programs. 

 Nonempty Programs: Select this option to view the programs that have the 
content. 

Preset button status LEDs: 

 Yellow: Only the switcher preset is bound to the button. 

 Blue: Only the media server program is bound to the button. 

 Purple: Both program and preset are bound to the button. 

 Green: The preset is selected. 

 Off: The preset is not used. 

 Perform other necessary operations as required. 

 Unbind a single button: Tap and drag NULL at the top to the target button. 

 Unbind all buttons: Tap Unbind All. 

 Press the preset button on the front panel to switch the program. 

 Press the CUT or TAKE button, or push the T-bar to play the programs. 

U5 and U5 Pro Event Controllers 

The control operations and settings on the U5 and U5 Pro are basically the same. 
Here we take the U5 Pro to illustrate. 

 Complete the physical connections. 

 Connect the U5 Pro and X400 to the same local area network by either directly 
connecting them with an Ethernet cable or connecting them through a router. 

 Connect the X400’s CONTROL UI connector to a monitor using an HDMI cable. 

 Connect the X400’s Type-A ports to a keyboard and a mouse using USB cables. 
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 Physical connections between the U5 Pro and X400 

 

 In Pilot MS3 on the monitor, click Event Controller in the upper right corner, as shown 
in Figure 11-5, to enable the X400 to be discovered by the U5 Pro and displayed in the 
device list of the U5 Pro screen, as shown in Figure 11-6. 

 Enabling the X400 to be discovered by the U5 Pro 
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 On the U5 Pro, select the target switcher, double tap it to enter the device operation 
page, and then tap Peripheral Management. 

 Peripheral management 

 

 From the device list of the U5 Pro screen, select your online media server. 

 Green: The media server is online.  

 Gray: The media server is offline. 

Operations: 

 : All the peripheral devices are automatically identified and listed here. You can 
also tap this icon to manually refresh the device list. 

 : Select the target device and tap this icon to delete the selected device. 

 On the U5 Pro screen, tap to select a program and on the displayed virtual preset 
button page, tap the target preset button to bind the program to the desired preset 
button. 

 Binding program to preset button 
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Binding rules are as follows: 

 One program can be bound to different buttons. 

 One button can be bound to only one program of a device. 

Operations: 

 Sync: After a different device is selected or a program changes, the program list 
will be synchronized automatically to the event controller.  

 Nonempty Program: Select this option to view the programs that have the content. 

Preset button status LEDs: 

 Yellow: Only the switcher preset is bound to the button. 

 Blue: Only the media server program is bound to the button. 

 Purple: Both program and preset are bound to the button. 

 Green: The preset is selected. 

 Off: The preset is not used. 

 Perform other necessary operations as required. 

 Unbind a single button: Tap NULL and on the displayed virtual preset button page, 
tap the target preset button. 

 Unbind all buttons: Tap Unbind. 

 Press the preset button on the front panel to switch the program. 

 Do the following to play the programs. 

 If the connected switcher is in PGM only mode, the selected program will be 
played directly after you press the preset button. 

 If the connected switcher is in switcher mode, press the CUT or TAKE button, or 
push the T-bar to play the programs. 

11.1.2 KVM Control 

U3 Event Controller 

 Complete the physical connections. 

 Connect the U3’s DVI INPUT connector to the X400’s CONTROL UI connector 
using a DVI to HDMI cable. 

 Connect the U3’s Type-B port to the X400’s Type-A port using a USB cable. 

 Connect a mouse and keyboard to the U3’s USB ports on the right side. 
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 Physical connections between the U3 and X400 

 

 Press the MVR button in the FUNCTION area on the U3 front panel, and the MVR 
button indicator turns green, indicating the U3 secondary screen is dedicated to the 
media server and displays the Pilot MS3 user interface. 

 On the U3, go to Settings > Event Controller to enter the virtual controller page. 

 On the secondary screen, complete the external screen settings. 

 Secondary screen – external screen settings 
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 Screen Quantity: Set the quantity of the screens loaded by the media server. The 
screen quantity equals the quantity of available output connectors on the output 
cards of the media server plus one.  

To confirm the screen quantity, click on the Pilot MS3 desktop to open Display 
settings and you will directly see the screen quantity. After the screen quantity is 
set, the screens will be displayed graphically under Screen Quantity. 

 Width & Height: Set the resolution of each screen. 

 Set as U3 Operation Screen: Set which of the screens is the one that displays the 
Pilot MS3 user interface. 

 Once you are done, use the mouse and keyboard of the event controller to operate 
the Pilot MS3 user interface. Any operations in Pilot MS3 can be easily done with the 
mouse and keyboard, such as program switching and playback. 

 When you move the cursor to the secondary screen, all your mouse and keyboard 
operations apply to Pilot MS3. 

 When you move the cursor to the primary screen, all your mouse and keyboard 
operations apply to the event controller. 

U5 and U5 Pro Event Controllers 

The control operations and settings on the U5 and U5 Pro are basically the same. 
Here we take the U5 Pro to illustrate.  

 Complete the physical connections. 

 Connect the U5 Pro’s MVR1, MVR2 or HDMI IN connector to the X400’s CONTROL 
UI connector using an HDMI cable. 

 Connect the U5 Pro’s MIDI/KVM port to the X400’s USB port using a USB cable. 

 Connect a mouse to the U5 Pro’s USB port on the right side. For the U5, you need 
to connect a mouse and keyboard to the U5’s USB ports on the right side because 
the U5 Pro has a built-in keyboard in the middle drawer on the front panel. 
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 Physical connections between the U5 Pro and X400 

 

 Press the MVR button on the U5 Pro front panel, and the MVR button indicator turns 
green. The ultrawide primary screen is divided into two screens. The secondary 
screen on the right half is dedicated to the Pilot MS3 user interface.  

For the U5, the primary screen will be dedicated to the Pilot MS3 user interface. 

 On the U5 Pro, select the target switcher, double tap it to enter the device operation 
page, and then tap KVM Settings. 

 On the displayed page, complete the KVM settings. 
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 KVM settings 

 

 Mouse Roaming: Toggle this switch to enable or disable the mouse roaming 
function. When enabled ( ), your mouse can roam across the event controller’s 
primary screen and the Pilot MS3 screen. You can also press the MEDIA button on 
the event controller front panel to enable or disable this function. 

 Input Source: Select the input connector on the event controller that the HDMI 
cable is connected to: MVR1, MVR2, or HDMI IN. This is to tell the event controller 
which input connector is used to display the Pilot MS3 user interface. Only when 
the correct input connector is selected, all your mouse and keyboard operations 
can successfully apply to Pilot MS3. 

 Add Screens: Set the quantity of the screens loaded by the media server. The 
screen quantity equals the quantity of available output connectors on the output 
cards on the media server plus one.  

To confirm the screen quantity, click on the Pilot MS3 desktop to open Display 
settings and you will directly see the screen quantity. After the screen quantity is 
set, the screens will be displayed graphically under Add Screens. 

 Width and Height: Set the resolution of each screen. 

 Main Screen: Set which of the added screens is the main screen that displays the 
Pilot MS3 user interface. 

 : You can tap this icon to add a new KVM preset. 

 / : Each KVM preset area has a radio button in the upper right corner. You 
can tap this button to select and enable the KVM preset. 

 Edit: If you want to manage the added KVM presets, tap Edit first. Then, you can 
change the KVM preset name, modify the KVM settings, or delete the KVM 
presets. 

 Once you are done, use the mouse and keyboard of the event controller to operate 
the Pilot MS3 user interface. Any operations in Pilot MS3 can be easily done with the 
mouse and keyboard, such as program switching and playback.  
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 When you move the cursor to the secondary screen, all your mouse and keyboard 
operations apply to Pilot MS3. 

 When you move the cursor to the primary screen, all your mouse and keyboard 
operations apply to the event controller. 

11.2 Control via Stream Deck 

The X400 media server also supports control through a third-party device (Stream 
Deck). When controlling through Stream Deck, it is necessary to complete the 
configuration of Stream Deck device through the Companion software. 

11.2.1 Software Obtaining and Preparations 

 User registration has been completed in companion official website 
(https://bitfocus.io/companion). 

 The supported Companion software version has been obtained from Pilot MS3 
technical support. 

 The computer with Companion installed is on the same network segment as the 
device with Pilot MS3. 

 The connection between Stream Deck and the device with Pilot MS3 has been 
completed. 

11.2.2 Software Configuration 

 After downloading the Companion installation package, double click the package to 
install the software. 

 After the installation, double click the Companion software shortcut to open the 
software. 

 Companion software interface 

 

 Click Launch GUI to enter the Companion configuration page. 
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 Companion configuration page 

 

 Enter the desired device or software name in the Add connection area search box on 
the Connections interface, and the system will automatically display all relevant 
product models or software names. 

 Search software 

 

 Click Add before the device model or software name you want to control. 

 After adding the device or software, the system enters the Edit Connection 
configuration interface. 

 Connection configuration 

 

 Configure the control device or program. 
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 Label: The name of the control device is required. The name can only contain 
letters, numbers, underscores and dashes. 

 IP Address: Enter the IP Address of the device to be controlled. If you control the 
software, you need to enter the IP Address of the device where the software is 
located. 

 UDP Port: Companion communicates with the controlled device through UDP. Fill 
in the UDP port number here, which defaults to 18960. If there is any change, 
please fill in the changed UDP port number. 

 Model: Select the controlled device or program. When there are multiple 
controllable programs on the device with the configured IP address, you need to 
select the controlled program name here. 

 Click Save to complete the connection configuration. 

If the configuration is correct, under the Connections tab, the status of the connected 

device is displayed as . 

 Device connection complete 

 

 Click Buttons to enter the Stream Deck button configuration interface. 

 Stream Deck button configuration 

 

 In the Presets area on the right, click the added control device or program to expand 
the preset function menu. 
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 Preset function menu 

 

 Expand the preset list on the right side, drag the preset buttons on the right side to 
the buttons of Stream Deck on the left side, and complete the button binding 
between the control function and Stream Deck.  

 Function binding 

 

 Note  

Since Stream Deck does not support page navigation horizontally, when adding 
functions to the buttons on the Stream Deck, make sure the number of buttons 
horizontally matches the physical device.  

 Click Back to select different function menu and complete more function bindings. 
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 More function binding 

 

 After the configuration is completed, the function name will be displayed on the 
button of Stream Deck. Press the corresponding button, and check whether the 
function bound to the button is triggered in the control program. 

 Yes = > Stream Deck is successfully configured.  

 No = > Contact your technical support to find out the reason and reconfigure. 

Other operations 

 Replace button function 

Directly drag a new function from the right side list to the target button to replace 
the existing function.  

 Delete button function 

Click Delete at the bottom to activate button function deletion. Click the function 
on the button that needs to be deleted to delete the corresponding function. 

 Clear button functions 

Select the button page that needs to be cleared, click Wipe page at the bottom to 
clear all the added buttons functions on that page. 

 Note  

For more information, please refer to the Companion user manual.  
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12 Specifications 

Electrical 
Specifications 

Power 
connector 

100–240V~, 10–5A, 47–63Hz 

Max power 
consumption 

650 W 

Operating 
Environment 

Temperature 0°C to 45°C 

Humidity 0% RH to 80% RH, non-condensing 

Storage 
Environment 

Temperature –10°C to +60°C 

Humidity 0% RH to 95% RH, non-condensing 

Physical 
Specifications 

Dimensions L 482.6 mm × P 694.7 mm × H 183.5 mm 

W 19 inch × D 27.45 inch × H 7.2 inch 

Weight 23.5 kg / 51.8 lbs  

(Fully loaded without accessories) 

57.2 kg / 126.1 lbs  

(Fully loaded with accessories & flight 
case) 

Noise on Average  
(@1, 0.75m height) 

Front: 51.8 dB 

Rear: 54.1 dB 

Packing 
Information 

• 2x DP to DP cables 

• 3x HDMI to HDMI cables 

• 1x AC power cable 

• 1x Grounding cable 

• 1x Keyboard & mouse 

• 1x Windows product key 

• 1x USB to audio adapter 

• 1x Quick Start Guide 

• 1x Customer Letter 

• 1x Safety Manual 

• 1x Certificate of Approval 



X400 Professional Media Server User Manual 12 Specifications 

 

www.pixelhue.com 114 
 

Certifications CE, RoHS, PSE, FCC, RCM, KC 

 Note 

If the product does not have the relevant certifications 
required by the countries or regions where it is to be 
sold, please contact PIXELHUE to confirm or address 
the problem. Otherwise, the customer shall be 
responsible for the legal risks caused or PIXELHUE has 
the right to claim compensation. 
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